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ОБЩИЕ УКАЗАНИЯ ПО ВЫПОЛНЕНИЮ 

ЛАБОРАТОРНЫХ РАБОТ 
 

При выполнении лабораторных работ студенты должны, изучив 
компоненты электронной лаборатории и имея навыки работы с 

ПЭВМ, освоить технологию разработки и исследования 

электрических схем отдельных узлов телеметрических систем, 
используемых для диагностических комплексов. 

Студенты обязаны ознакомиться  с графиком проведения 

лабораторных работ и в процессе самостоятельных занятий изучить 

методические указания по выполняемым работам, соответствующий 
лекционный материал и разделы рекомендованной литературы. 

При работе на ПЭВМ студенты должны соблюдать «Правила 

эксплуатации устройств электроустановок» и предписания 
методических указаний, а также выполнять требования 

преподавателя. 

Отчет по лабораторной работе следует оформить в тетради в 

соответствии с требованиями к содержанию отчета, приведенными в 
методических указаниях. 

Схемы, рисунки и графики должны быть выполнены чертежными 

принадлежностями или распечатаны на принтере с соблюдением 
требований на условные графические изображения. 

Отчет должен содержать результаты исследований и 

моделирования на ПЭВМ, выводы и полный ответ на один из 
контрольных вопросов, помещенных в конце каждой лабораторной 

работы. Оформленный и подписанный студентом отчет 

представляется преподавателю перед началом очередного занятия. 

Студенты, не оформившие отчет по предыдущей работе, к 
последующим лабораторным занятиям не допускаются. 
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Л а б о р а т о р н а я  р а б о т а № 1   

 

ИЗУЧЕНИЕ  КОМПОНЕНТОВ  

ЭЛЕКТРОННОЙ ПРОГРАММЫ EWB 

 

 Цель работы: изучить аналоговые и дискретные 
комплектующие изделия для электрических схем, их условные 

обозначения и изображения на экране монитора, технологию 

установки и фиксации электрических параметров для компонентов с 

изменяемыми электрическими характеристиками.  

1 Краткие сведения из теории 

Для  изучения и исследования принципиальных электрических 

схем узлов телеметрических систем целесообразно ознакомиться с 
компонентами и библиотекой готовых схем программы EWB. 

Компоненты сгруппированы по  функциональным признакам. 

  

1.1 Группа Favorites – вспомогательные компоненты 

В разделе Favorites программы EWB 5.0 размещаются схемные узлы 

новых устройств, а также все библиотечные компоненты предыдущей 
версии EWB 4.0, расположенные  в разделе Custom. Заполнение раздела 

моделями компонентов или подсхем осуществляется программой 

автоматически, одновременно с загрузкой схемного файла и очищается 

после окончания работы с ним. 

 

1.2 Группы Sources и Basic  
 

Разделы Sources и Basic содержат элементы электрических схем и 
управляемые источники: 

 
Заземление (метка). 

 

Батарея (напряжение). 

 

Источник постоянного тока (ток). 
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Источник переменного синусоидального 

напряжения  (эффективное значение 

напряжения, частота, фаза). 

 

Источник переменного синусоидального тока 

(эффективное значение тока, частота, фаза). 

 
Резистор (сопротивление). 

 

Конденсатор (емкость). 

 
Катушка (индуктивность). 

 

Трансформатор с возможностью 

редактирования: 

 коэффициента трансформации (Primary-to-secondary turns ratio); 

 индуктивности рассеяния (Leakage inductance Le, Гн); 

 индуктивности первичной обмотки (Magnetizing inductance Lm, 
Гн); 

сопротивления первичной обмотки (Primary winding resistance 

Rp, Ом); 

 сопротивления вторичной обмотки (Secondary winding resistance 

Rs, Ом). 

 
Предохранитель (ток срабатывания). 

 

Источник произвольного постоянного напряжения и 

последовательно включенный резистор (напряжение, 
сопротивление). 

 

Конденсатор переменной емкости (аналогично    
потенциометру). 
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Потенциометр, параметры задаются с помощью 

диалогового окна (рисунок 1), где первый параметр 

Key определяет символ клавиши клавиатуры (по 

умолчанию R), нажатием которой сопротивление 
уменьшается на заданную величину, %, (параметр 

Increment, подвижный контакт двигается влево) или 

увеличивается на такую же величину нажатием 
комбинации клавиш Shift+R (подвижный контакт 

двигается вправо); второй параметр – номинальное 

значение сопротивления; третий – начальная 

установка сопротивления, % (по умолчанию – 50 %). 

 

 
Рисунок 1 – Диалоговое окно задания параметров потенциометра 

 

 
Катушка переменной индуктивности (аналогично 

потенциометру). 

 

 

Электролитический конденсатор (емкость). 

 

Сборка из восьми независимых резисторов 

одинакового номинала  (сопротивление). 
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Генератор однополярных прямоугольных 

импульсов (амплитуда, частота, коэффициент 

заполнения). 

 
Генератор амплитудно-модулированных колебаний 
(напряжение и частота несущей, коэффициент и 

частота модуляции; на значке графического 

изображения компонента коэффициент модуляции не 
указан). 

 

Генератор частотно-модулированных колебаний 

(напряжение и частота несущей, индекс и частота 
модуляции; на значке компонента индекс модуляции 

не указан). 

 

1.3 Группа Control – коммутационные устройства  

и управляемые источники  

 
Переключатель, управляемый нажатием 
задаваемой клавиши клавиатуры (по умолчанию – 

клавиша пробела). 

 

Переключатель, автоматически 

срабатывающий через заданное время на 
включение и выключение (время включения и 

выключения, с). 

 

Выключатель, срабатывающий в заданном 
диапазоне входных напряжений или токов 

(напряжение или ток включения и 

выключения). 

 

Источники напряжения, управляемые током 

или напряжением (коэффициент передачи). 

 

Источники тока, управляемые током или 

напряжением (коэффициент передачи). 

 

Реле с перекидным контактом (ток 

срабатывания и отпускания, индуктивность 

обмотки). 
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Полиномиальный источник питания. 

1.4 Группа Diodes and Active – диоды и  

активные компоненты 

Раздел Diodes содержит полупроводниковые диоды, биполярные 

транзисторы, операционные усилители, аналоговые делительное и 

множительное устройства, а также линии связи. 
 

 
Полупроводниковый диод (тип). 

 
Стабилитрон (тип). 

 
Светодиод (тип). 

 

Биполярные n-р-n- и p-n-p-транзисторы соответственно 
(тип). 

 
Линейная модель операционного усилителя (тип). 

 
Нелинейная модель операционного усилителя (тип). 

 Тиристор или динистор (тип). 

 
Диод Шокли или динистор с 4 р-n-переходами. 

 
Симметричный динистор  (тип). 

 
Симметричный тринистор  (тип). 

 
Выпрямительный мост (тип). 

 
Аналоговый умножитель (коэффициент передачи).  

 

Линия передачи с потерями, характеризуемая 

параметрами: 

 

 длина линии (Length of the Transmission Line Len, м); 
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 сопротивление на единицу длины (Resistance per unit length Rt, 

Ом/м); 

 индуктивность на единицу длины (Inductance per unit length Lt, Гн/м); 

 емкость на единицу длины (Capacitance per unit length Ct, Ф/м); 

 проводимость на единицу длины (Conductance per unit length Gt, 
См/м); 

 количество последовательно включенных элементарных 

сегментов (Number of Lumps n). 

Линия передачи без потерь с возможностью редактирования: 

 волнового сопротивления (Nominal Impedance Zo, Ом); 

 времени задержки распространения сигнала в линии (Propogation 
Time Delay Td, с); 

 количества последовательно включенных элементарных 

сегментов (Number of Lumps n). 

1.5 Группа Transistors – транзисторы 

Раздел Transistors содержит полевые транзисторы в следующем 

составе: 

 
Полевые транзисторы с управляющим p-n-

переходом (тип) 

 

Полевые МОП-транзисторы со встроенным 

каналом (Depletion MOSFETs), n-канальные и р-

канальные, с раздельными или соединенными 

выводами подложки и истока (тип). 

 

Полевые МОП-транзисторы с индуцированным 

каналом (Enhancement MOSFETs), n-канальные и 
р-канальные, с раздельными или соединенными 

выводами подложки и истока (тип). 

1.6 Группа  Hybrid – гибридные компоненты 

     Для компонентов библиотеки Hybrid, за исключением таймера, 
допускается редактирование в диалоговом окне следующих 

параметров: 
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 верхний уровень входного напряжения (High-Level Input 

Voltage Vih, В); 

 нижний уровень входного напряжения (Low-Level Input Voltage 
Vil, В); 

 время установления при переходе от нижнего уровня к 

верхнему и наоборот    (Propagation Delay Time. Low-to-High Level 

Output Tplh;Propagation Delay Time, High-to-Low Level Output Tphl, 
c); 

 пороговое напряжение (Threshold Voltage Vth, B). 

     Например, для АЦП (ADC) первые два параметра обозначают 

диапазон преобразуемых напряжений, третий – время 
преобразования, четвертый – цена младшего разряда. 

 

8-разрядный АЦП. 

 

8-разрядный ЦАП с внешними опорными 
источниками тока и парафазным выходом. 

 

8-разрядный ЦАП с внешними опорными 

источниками напряжения. 

 

Моностабильный мультивибратор. 
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Популярная микросхема 

многофункционального таймера 555, 
отечественный аналог – КР1006ВИ1. 

 

 

1.7  Группа Indic – индикаторные приборы  

Раздел Indic содержит амперметр и вольтметр с цифровым 

отсчетом, одиночные и многосегментные светоиндикаторы, 8-

разрядное устройство записи данных и звуковой сигнализатор 
(зуммер). 

 

 

Вольтметр (внутреннее сопротивление, режим 

измерения постоянного или переменного тока). 
 

 

Амперметр (внутреннее сопротивление, режим 

измерения постоянного или переменного тока). 
 

 

Лампа накаливания (напряжение, мощность). 

 
Светоиндикатор (цвет свечения устанавливается). 

 

Семисегментный индикатор (тип). 

 

Семисегментный индикатор с дешифратором (тип). 

У семисегментных индикаторов редактируемые 

параметры такие же, как и в группе Hybrid. 

 

8-разрядное устройство записи данных в текстовом 

режиме. 
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Звуковой индикатор (зуммер) (частота звукового 
сигнала, напряжение и ток срабатывания 

устанавливаются). 

 

Линейка из десяти независимых светодиодов 

(напряжение, номинальный и минимальный ток). 
 

 

Линейка из десяти светодиодов со встроенным 
АЦП (минимальное и максимальное напряжение). 

 

1.8  Группа Gates – логические элементы 

Группа Gates состоит из моделей базовых логических элементов и 
моделей цифровых интегральных микросхем ТТЛ- и КМОП- серий.  

 
Логические элементы И, И-НЕ (количество входов). 

 

Логические элементы ИЛИ, ИЛИ-НЕ (количество 

входов). 

 
Логические элементы ИСКЛЮЧАЮЩЕЕ ИЛИ и 

ИСКЛЮЧАЮЩЕЕ ИЛИ-НЕ (количество входов). 

 

Логические элементы НЕ, буфер и тристабильный 
буфер – элемент с тремя состояниями. 

  

 
 

 

 

 

Цифровые ИМС ТТЛ- и КМОП-серий (тип микроросхемы). 

 

1.9 Группа Соmb’I – комбинированные цифровые компоненты 

AND 

 
NAND 

 
OR 

 
NOR 

NOT XOR 

 
XNOR BUFFERS 
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Полусумматор (тип). 

 

 

Полный сумматор (тип). 

 
                               

Серийные микросхемы мультиплексоров, декодеров/демультиплексоров, 

кодеров, элементов арифметико-логических устройств (тип микросхемы). 
 

1.10  Группа Seg’I – триггеры 

    

 

RS-триггер (тип). 

 

JK-триггеры с прямым или инверсным тактовым 

входом и входами предустановки (тип). 
 

 

D-триггеры без предустановки и со входами 
предустановки (тип). 

 

 

Серийные микросхемы триггеров, счетчиков и регистров (тип 

микросхемы). 

1.11 Группа IС – цифровые микросхемы 

ENCODERS 

 
DEC/DEMUX MUX ARITHMETIC 

FLIP-FLOPS COUNTERS SHIFT REGS 

74хх 

 

 

741хх 742хх 743хх 74ххх 
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В группе IС собраны модели цифровых ИМС серий SN74 и CD4000 
(отечественные ИМС серий 155 и 176 соответственно). Для 

конкретных ИМС вместо символов хх ставятся соответствующие 

номера, например, SN7407 6 буферных элементов с открытым 

коллектором, CD4081 – 4 элемента 2И и т. д. 

1.12 Библиотека компонентов EWB 5.0 

Библиотека компонентов программы EWB 5.0 несколько 

расширена и существенно переработана за счет перегруппировки 
компонентов. Эта библиотека содержит следующие разделы: 

1 Favorites – раздел, аналогичный группе Custom в EWB 4.1. 

2 Sources – источники сигналов (меню для выбора компонентов 
показано на рисунке 2). Раздел дополнен несколькими управляемыми 

источниками. Здесь под источниками сигналов подразумеваются не 

только источники питания, но и управляемые источники. 

3 Basic – раздел, в котором собраны все пассивные компоненты, а 
также коммутационные устройства (рисунок 3). 

 

                  

 
Рисунок 2 – Меню раздела Sources 

 
Рисунок 3 – Меню раздела Basic 

Важным дополнением являются модели с нелинейной 

индуктивностью, в том числе трансформаторы с сердечником. 
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Интересной особенностью наделена в этом разделе точка соединения, 
параметры которой можно задавать с помощью диалогового окна на 

рисунке 4. Она может быть наделена такими свойствами, как 

отсутствие (Open) соединения между проводниками, подключенными 
к ней с соответствующей стороны (цифры 1–4 на рисунке 4 

определяют количество и направление соединяемых проводников). 

Например, при включенных опциях 1, 3 и Open между проводниками, 
подключенными со сторон 1 и 3, не будет электрического 

соединения.  

4 Diodes – диоды (рисунок 5). Ничего нового в семейство диодов 

не добавлено.  
5 Transistors – транзисторы (рисунок 6). К семейству 

транзисторов добавлены (по сравнению с EWB 4.1) р- и n-канальный 

полевые транзисторы (см. рисунок 6, б). В качестве их 
математических моделей используются модели однопереходных 

транзисторов.  

6 Analog ICs – аналоговые микросхемы (рисунок 7, а). К 

семейству аналоговых микросхем добавлены две разновидности 
операционных усилителей (рисунок 7, б, в), компаратор напряжения 

(рисунок 7, г) и микросхема для систем фазовой автоподстройки 

частоты (рисунок 7, д), состоящая из фазового детектора, фильтра 
нижних частот и генератора, управляемого напряжением. 
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Рисунок 4 –  Окно установки параметров точки соединения 

 

Рисунок 5 – Меню раздела Diodes 

 

а) б) 

Рисунок 6 – Меню раздела Transistors (а) и графическое изображение арсенид–
галлиевых полевых транзисторов (б) 

 
 

 

 

а)  б) в) г) д) 

Рисунок 7 – Меню раздела Analog Ics (а) и графическое обозначение операционных 
усилителей с семью (б) и девятью (в) выводами, компаратора (г) и микросхемы для 

систем автоподстройки частоты (д) 

 
7 Mixed Ics – микросхемы смешанного типа (рисунок 8). 

Содержание раздела полностью идентично содержанию группы Hy-

bryd EWB 4.1, т. е. в него входят 8-разрядный АЦП, два типа ЦАП (с 
внешними опорными источниками тока или напряжения), 

мультивибратор и интегральный таймер. 

8 Digital Ics – цифровые микросхемы (рисунок 9). Раздел 

полностью аналогичен рассмотренной выше группе IC с несколько 
расширенным количеством ИМС.  



 20 

9 Logic Gates – логические цифровые микросхемы (рисунок 10). 
Раздел полностью аналогичен рассмотренной выше группе Gates; 

добавлен элемент НЕ на базе триггера Шмитта. 

10 DIGITAL – цифровые микросхемы (рисунок 11). В разделе 
объединены компоненты групп Comb’I и Seg’I.  

11 Indicators – индикаторные устройства (рисунок 12). Раздел 

соответствует группе Indic, изменено лишь графическое обозначение 
зуммера (седьмая иконка на рисунке 12). 

 

  

Рисунок 8 – Меню раздела Mixed Ics Рисунок 9 –  Меню раздела Digital Ics 

 

 
Рисунок 10 – Меню раздела Logic Gates 

 
Рисунок 11 – Меню раздела Digital 

 
Рисунок 12 – Меню раздела Indicators 

 

12 Controls – аналоговые вычислительные устройства (рисунок 
13). Этот раздел наиболее насыщен новыми моделями. Кроме 
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аналоговых делительных и множительных устройств, ранее 
входивших в группу Active, сюда включены (см. рисунок 13, б) 

дифференциатор, интегратор, масштабирующее звено, 

формирователь передаточных функций, трёхвходовый сумматор, 
управляемый ограничитель напряжения, неуправляемый 

ограничитель напряжения, ограничитель тока, блок с гистерезисной 

характеристикой и селектор сигналов. 
13 Miscellaneous – компоненты смешанного типа (рисунок 14). В 

раздел включены новые компоненты, показанные на рисунке 14, б. 

На этом рисунке приведены (сверху вниз, слева направо) фильтры- 

накопители BOOST, BUCK, BUCK – BUST, кварцевый резонатор, 
коллекторный электродвигатель постоянного тока, 

электровакуумный триод.  

Рисунок 13 – Меню раздела Controls (а) и его новые компоненты (б)  

а) 

 

а) 

 

б) 
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б) 

 
Рисунок 14 – Меню раздела Miscellaneous (а) и его основные компоненты (б) 

2 Порядок выполнения работы 

1 Ознакомьтесь с методикой работы  в среде программы 

«Электронная лаборатория на ЭВМ» по пособию [1]. По указанию 
преподавателя включить ЭВМ. 

2 Составьте схему цепи, состоящей из последовательно 

включённых батареи напряжением 5 В и переменного резистора 
сопротивлением 10 кОм, включенного потенциометром. Между 

подвижным контактом потенциометра и одним из зажимов батареи 

включите вольтметр. Изменяя положение подвижного контакта 

нажатием назначенной вами клавиши клавиатуры, по показанию 
вольтметра определите направление его перемещения. 

3 Подготовьте схему цепи, состоящей из источника переменного 

синусоидального напряжения и вольтметра. Установите напряжение 
источника 10 В. Полагая, что вольтметр измеряет эффективное 

значение напряжения, выясните, какому значению соответствует 

установленное напряжение источника – эффективному или 

амплитудному. 
Проведите исследование схемы при напряжении источника 5 и 15 В. 

4 Составьте схему цепи, состоящей из последовательно 

включенных источника постоянного тока, амперметра и 
потенциометра 10 кОм, включенного в режиме переменного 

сопротивления (к схеме подключается вывод подвижного контакта и 

одного из неподвижных). Изменяя сопротивление резистора 
назначенной клавишей, убедитесь, что ток в цепи не меняется. 

Объясните почему? 

5 Соберите цепь, состоящую из источника постоянного тока и 

предохранителя, установив ток срабатывания 10 мА. Изменяя ток 
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источника, установите факт срабатывания предохранителя при 
указанном значении тока. 

6 Подключите вольтметр к генератору прямоугольных 

импульсов, установив амплитуду выходного сигнала 10 В. 
Установите, почему измеряемое вольтметром напряжение равно 

половине установленного как в режиме измерения постоянного, так и 

переменного тока? Сделайте вывод о форме выходного сигнала 
генератора. 

7 Подготовьте схему цепи, состоящей из последовательно 

включенных источника постоянного напряжения, резистора 1 кОм и 

стабилитрона. Параллельно стабилитрону подключите вольтметр. 
Установите зависимость напряжения на стабилитроне от напряжения 

источника. Полученное напряжение стабилизации сравните со 

значениями параметров модели стабилитрона. 
8 Составьте схему цепи, состоящей из двух батарей напряжением 

2 и 12 В, аналогового умножителя и вольтметра. Одну батарею 

подключите ко входу Х, вторую – ко входу Y умножителя, а к его 

выходу – вольтметр. Убедитесь в правильности функционирования 
умножителя. 

9 Соберите схему, состоящую из последовательно включенных 

источника постоянного тока и реле. Изменяя ток источника, 
убедитесь в правильности функционирования реле. 

10 Соберите схему, состоящую из батареи  и лампы накаливания. 

Определите напряжения, при которых лампа зажигается и 
перегорает. 

11 Зарисуйте собранные схемы, сформулируйте выводы по работе, в 

которых отразите общие правила  применения компонентов EWB.  

Содержание отчета 

Наименование и цель работы, краткая характеристика 

используемых компонентов и схем программы ЕWB с кратким их 

описанием, схемы исследуемых цепей, результаты измерений,  

ответы на контрольные вопросы, выводы по работе. 

Контрольные вопросы и задания 

1  Каким образом можно подключить вывод компонента к проводнику? 
2 Какие компоненты располагаются в каталогах библиотек Custom и Favorites? 
3 Назовите элементы для образования в схеме узла соединений? Какие 

дополнительные функции он может выполнять? 
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4 При подготовке схемы иногда возникает необходимость перемещения её 
отдельных фрагментов. Каким образом это можно сделать, не используя линейку 
прокрутки или перетаскивание отдельных символов компонентов курсором? 

5 Как определить напряжение срабатывания светового индикатора? 
6 Назовите основные отличия библиотек компонентов EWB версии 4.1 и версии 

5.0. 

 

Л а б о р а т о р н а я  р а б о т а № 2   

ИЗУЧЕНИЕ  ТЕХНОЛОГИИ СОСТАВЛЕНИЯ 

ЭЛЕКТРИЧЕСКИХ СХЕМ В ЭЛЕКТРОННОЙ СРЕДЕ EWB 

 

 Цель работы: изучить процесс создания и исследования  

электрических схем в среде EWB. 

1 Краткие сведения из теории 

Для создания    принципиальной электрической схемы средствами 

программы EWB,  необходимо на листе бумаги подготовить ее эскиз 

с примерным расположением компонентов и с учетом возможности 

оформления отдельных фрагментов в виде подсхем. Целесообразно 
также ознакомиться с библиотекой готовых схем программы (см. 

лабораторную работу № 1) для выбора аналога (прототипа) или 

использования имеющихся решений в качестве подсхем. 
В общем случае процесс создания схемы начинается с 

размещения на рабочем поле EWB компонентов из библиотек 

программы в соответствии с подготовленным эскизом.  Разделы 
библиотеки программы EWB 4.1 поочередно могут быть вызваны с 

помощью меню Windows или с помощью иконок, расположенных 

под линейкой контрольно-измерительных приборов (окно программы 

EWB 4.1) либо с помощью иконок, расположенных под линейкой 
стандартных иконок Windows (окно программы EWB 5.0). Каталог 

выбранной библиотеки располагается в вертикальном окне справа 

или слева от рабочего поля (устанавливается в любое место 
перетаскиванием стандартным способом – за шапку заголовка). Для 

открытия каталога нужной библиотеки необходимо подвести курсор 

мыши к соответствующей иконке и нажать один раз ее левую кнопку, 
после чего серый фон иконки меняется на желтый. Необходимый для 

создания схемы значок (символ) компонента переносится из каталога 

на рабочее поле программы движением мыши при нажатой левой 
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кнопке, после чего кнопка отпускается (для фиксирования символа) и 
производится двойной щелчок по значку компонента. В 

раскрывающемся диалоговом окне устанавливаются требуемые 

параметры (сопротивление резистора, тип транзистора и т.д.) и выбор 
подтверждается нажатием кнопки Ассерt или клавиши Епtег. На 

этом этапе необходимо предусмотреть место для размещения 

контрольных точек и иконок контрольно-измерительных приборов. 
Если в схеме используются компоненты одинакового номинала 

(например, резисторы с одинаковым сопротивлением), то номинал 

такого компонента рекомендуется задать непосредственно в каталоге 

библиотеки и затем переносить компоненты в нужном количестве на 
рабочее поле. Для изменения номинала компонента необходимо два 

раза щелкнуть мышью по символу его графического изображения и в 

раскрывающемся после этого окне внести изменения. 
При размещении компонентов схемы на рабочем поле программы 

EWB 5.0 можно воспользоваться динамическим меню, описанным в 

конце раздела. 

После размещения компонентов производится соединение их 
выводов проводниками. При этом необходимо учитывать, что к 

выводу компонента можно подключить только один проводник. Для 

выполнения подключения курсор мыши подводится к выводу 
компонента и после появления прямоугольной площадки синего 

цвета нажимается левая кнопка и появляющийся при этом проводник 

протягивается к выводу другого компонента до появления на нем 
такой же прямоугольной площадки, после чего кнопка мыши 

отпускается, и соединение готово. При необходимости подключения 

к этим выводам других проводников в библиотеке Passive выбирается 

точка (символ соединения) и переносится на ранее установленный 
проводник. Чтобы точка почернела (первоначально она имеет 

красный цвет), необходимо щелкнуть мышью по свободному месту 

рабочего поля. Если эта точка действительно имеет электрическое 
соединение с проводником, то она полностью окрашивается черным 

цветом. Если на ней виден след от пересекающего проводника, то 

электрического соединения нет и точку необходимо установить 
заново. После удачной установки к точке соединения можно 

подключить еще два проводника. Если соединение нужно разорвать, 

курсор подводится к одному из выводов компонентов или точке 

соединения и при появлении площадки нажимается левая кнопка, 
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проводник отводится на свободное место рабочего поля, после чего 
кнопка отпускается. Если необходимо подключить вывод к 

имеющемуся на схеме проводнику, то проводник от вывода 

компонента курсором подводится к указанному проводнику и после 
появления точки соединения кнопка мыши отпускается. Следует 

отметить, что прокладка соединительных проводников производится 

автоматически, причем препятствующие компоненты и другие 
проводники огибаются по ортогональным направлениям (по 

горизонтали или вертикали). 

Точка соединения может быть использована не только для 

подключения проводников, но и для введения надписей (например, 
указания величины тока в проводнике, его функционального 

назначения и т. п.). Для этого необходимо дважды щелкнуть по точке 

и в раскрывшемся окне ввести необходимую запись (не более 14 
символов), причем запись можно смещать вправо путем введения 

слева нужного количества пробелов. Это свойство может быть 

использовано и в том случае, когда позиционное обозначение 

компонента (например С1, R10) накладывается на рядом проходящий 
проводник или другие элементы схемы. 

Если необходимо переместить отдельный сегмент проводника, к 

нему подводится курсор, нажимается левая кнопка и после появления 
в вертикальной или горизонтальной плоскости двойного курсора 

производятся нужные перемещения. 

Подключение к схеме контрольно-измерительных приборов 
производится аналогично. Причем для таких приборов, как 

осциллограф или логический анализатор, соединения целесообразно 

проводить цветными проводниками, поскольку их цвет определяет 

цвет соответствующей осциллограммы. Цветные проводники 
целесообразны не только для обозначения проводников одинакового 

функционального назначения, но и для проводников, находящихся в 

разных частях схемы (например, проводники шины данных до и 
после буферного элемента). Примеры такого оформления можно 

найти в каталогах готовых схем (см. файл аdс-dас1.са4 – схемы 

включения библиотечных АЦП и ЦАП с опорным источником тока – 
Л1). 

При обозначении компонентов необходимо придерживаться 

рекомендаций и правил, предусмотренных ЕСКД (единой системой 

конструкторской документации). Что касается пассивных компонентов, 
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то при выборе их обозначений особых трудностей не возникает. 
Трудности возникают при выборе активных элементов микросхем, 

транзисторов и т. п., особенно при необходимости использования 

компонентов отечественного производства, когда требуется установить 
точное соответствие функциональных обозначений выводов и 

параметров зарубежных и отечественных компонентов. Для облегчения 

этой задачи можно воспользоваться таблицами соответствия 
зарубежных и отечественных компонентов, приведенными в пособии 

[2]. 

При   импортировании   в   создаваемую   схему  другой   схемы   

или   ее   фрагментов, целесообразно действовать следующим 
образом: 

 командой File>Save As записать в файл создаваемую схему, 

указав его имя в диалоговом окне (расширение имени файла 

указывать не обязательно, программа сделает это автоматически);  

 командой File>Open  загрузить    на    рабочее    поле    
импортируемую    схему стандартным для Windows образом;  

 командой Edit>Select All выделить схему, если импортируется 

вся схема, или выделить ее нужную часть; 

 командой Edit>Сору скопировать выделенную схему в буфер 

обмена; 

 командой File>Open загрузить создаваемую схему; 

 командой Edit>Paste вставить содержимое буфера обмена на 
рабочее поле; после вставки импортируемая схема будет выделена (и 

отмечена красным цветом) и может оказаться наложенной на 

создаваемую схему; 

 клавишами управления курсором (или ухватившись мышью за 

один из компонентов) отбуксируйте импортированную часть в 
нужное место, после чего можно отменить выделение; 

 после   подключения   импортированной   схемы    необходимо   

щелчками   мыши пройтись по всем ее компонентам, чтобы исключить 

их смещения, возникающие при буксировке и приводящие к 
ступенчатым искажениям проводников. Перемещения  отдельных  

фрагментов схемы  при  ее  компоновке  выполняются 

вышеописанным    образом    после    выделения   фрагмента.    Если    
схема   состоит   из однотипных блоков, то целесообразно 

скомпоновать один такой блок, а затем путем копирования   и   вставки   
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размножить   его   до   нужного   количества   и   выполнить 
необходимые соединения. 

После подготовки схемы рекомендуется составить ее описание 

(окно-ярлык вызывается из меню Window>Description), в котором 
указывается ее назначение; после проведения моделирования 

указываются его результаты. Программа EWB позволяет вводить 

описание только на английском языке. Кроме того, в EWB  не 
предусмотрены средства для редактирования графических 

изображений компонентов, а также введения новых шрифтов (только 

для  EWB 4.1). 

При описании библиотечных компонентов  после названия 
компонента в скобках указываются назначаемые пользователем 

параметры. Например, для конденсатора это емкость, значение 

которой может быть установлено с помощью диалогового окна Ca-
pacitor, а также температурные коэффициенты и разбросы (для EWB 

5.0), для операционного усилителя – тип, который может быть 

выбран с помощью меню Opamp Models, и т. д. 

2 Порядок выполнения работы 

1 Ознакомьтесь с методикой работы  в среде программы 

«Электронная лаборатория на ЭВМ» по пособию [1]. 

2 По указанию преподавателя включите ЭВМ. 
3 Используя схемы лабораторной работы № 1, выделите часть 

схемы и попытайтесь переместить ее в другое место экрана, 

пользуясь клавишами управления курсором или мышью.  

4 Используя команду Export, преобразуйте схему из лабораторной 
работы № 1 в формат PSpice и составьте комментарий к полученному 

текстовому файлу. Используя команду Import, преобразуйте 

полученный файл из формата PSpise в формат EWB 5.0. 
 

Содержание отчета 

Наименование и цель работы, краткая характеристика 

используемых опций и  приборов программы ЕWB с кратким их 

описанием, схемы исследуемых цепей и результаты их 
преобразования, ответы на контрольные вопросы, выводы по работе. 

 

Контрольные вопросы и задания 
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1 Какой командой можно восстановить схему в ее первоначальном виде после 
внесения изменений?  

2 Какой командой можно присвоить компоненту позиционное обозначение (C1, 
C2, R1 и т. д.) и какое правило используется при присвоении позиционных 
обозначений однотипным компонентам?  

3 Какими командами можно изменить цвет проводника и для чего это нужно? 

4 Каким образом можно масштабировать размеры изображения схемы? 
5 Назовите команду EWB 5.0 для задания параметров контрольно-

измерительных приборов. 

 
 

Л а б о р а т о р н а я  р а б о т а № 3   

ИЗУЧЕНИЕ  ЕМКОСТНЫХ ИЗМЕРИТЕЛЬНЫХ 

ПРЕОБРАЗОВАТЕЛЕЙ  

 

Цель работы: изучить принципы построения и 

функционирования ёмкостных измерительных преобразователей, 
исследовать  электрические схемы емкостных датчиков  в среде Elec-

tronics Workbench. 

  

1 Краткие сведения из теории 

Принцип действия измерительных  ёмкостных преобразователей 

(в дальнейшем ИП и датчиков) основан на изменении ёмкости 
конденсатора при воздействии входной преобразуемой величины на 

один из его конструктивных параметров в соответствии с формулой:  

 
 С = εεоS/δ, (1) 

 

где ε – относительная диэлектрическая проницаемость диэлектрика; 

 εо – электрическая постоянная, εо = 8,85 · 10-12 Ф/м;  
  S – площадь перекрытия пластин, м2; 

 δ  – толщина диэлектрика или расстояние между пластинами, м. 

Как следует из формулы (1), изменение площади перекрытия пластин 
S за счёт их взаимного перемещения приводит к линейной функции 

преобразования С = f(X) (рисунок 1, а); в данном случае С = εεоaX/δ , где a 

– ширина пластины. Аналогичным образом могут быть 
преобразованы и угловые перемещения при вращательном движении. 

Из формулы (1) видно, что при изменении расстояния δ  между 

пластинами конденсатора функция преобразования является 
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нелинейной (рисунок 1, б), поэтому такие ИП используются 
преимущественно для преобразования малых перемещений. 

Ёмкостные ИП с изменяемой диэлектрической проницаемостью 

обладают линейной характеристикой, смещённой относительно 
начала координат за счёт начальной ёмкости (рисунок 1, в). 

Конструктивно ИП ёмкостных датчиков могут быть выполнены с 

плоскопараллельными, цилиндрическими, штыревыми электродами, 
с наличием или отсутствием диэлектрика между пластинами. 

Преобразователи с изменением диэлектрической проницаемости 

используются для измерения уровня жидких и сыпучих материалов, 

анализа состава и концентрации веществ в химической, 
нефтеперерабатывающей промышленности, температуры, давления, а 

также для подсчёта изделий, охранной сигнализации и т. п. 

Для повышения чувствительности и линейности 
характеристик используют дифференциальные преобразователи, 

у которых изменение состояния контролируемой величины 

приводит к изменению ёмкости одновременно в двух 

чувствительных элементах, включаемых в разные плечи 
мостовой измерительной схемы. В этом случае формируется 

реверсивная (двухтактная) статическая характеристика: при 

изменении направления перемещения подвижного элемента ИП 
фаза выходного сигнала меняется на 180º относительно фазы 

напряжения питания, что фиксируется фазовым детектором. 

Немаловажное значение для повышения чувствительности ИП 
(чувствительность определяется по формуле S = ∆C/C0) имеет 

уменьшение начального значения ёмкости С0, куда входит и 

ёмкость измерительной схемы. Если для ИП на рисунке 1, а,  

значение С0 может быть сведено к пренебрежимо малым 
значениям, то для остальных двух схем наличие С 0 неизбежно. 
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       a)                               б)                               в) 

 
Рисунок 1 – Конструктивные схемы ИП ёмкостных датчиков 

  

Погрешность ёмкостных ИП, определяемая влиянием температуры 
и влажности, в значительной степени зависит от оптимального выбора 

конструкционных материалов и возможностей герметизации. 

Достоинства ёмкостных ИП: простота конструкции, малые 
размеры и масса, высокая чувствительность и разрешающая 

способность, отсутствие подвижных токосъёмных контактов, 

высокое быстродействие, возможность функционального 

преобразования за счёт соответствующего выбора формы электродов, 
практически полное отсутствие влияния на объект контроля. 

Недостатки ИП: сравнительно низкий уровень выходного сигнала, 

нестабильность характеристик при изменении параметров 
окружающей среды, влияние паразитных ёмкостей. 

Для согласования ёмкостных ИП, обладающих достаточно 

высоким выходным сопротивлением даже при сравнительно высокой 
частоте питающего напряжения (105–107 Гц) с последующими 

схемами преобразования, используются операционные усилители 

(ОУ) с высоким входным сопротивлением, которые по возможности 

располагаются в непосредственной близости от ИП и тщательно 
экранируются. Одиночные (недифференциальные) ИП обычно 

включаются по схеме делителя напряжения (рисунок 2, а) с 

использованием инвертирующего усилителя на ОУ с конденсатором 
(элементом делителя в цепи обратной связи). Показанные на рисунке 

2, а конденсаторы С1е, С2е, С3е имитируют ёмкости элементов 

схемы относительно экранов или линий связи и практически не 
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оказывают влияния на результат измерения, поскольку они 
оказываются подключёнными к низкоомным цепям (ёмкости С1е и 

С3е) или к точке с нулевым потенциалом (ёмкость С2е); выходное 

напряжение схемы 
 

                                        U0 = Ui C1/C2.                                      (2) 

 
При указанных на схеме значениях входящих в формулу (2) 

параметров U0 = 1 · 9 · 10-12/10 · 10-12 = 0,9 В, что совпадает с 

показаниями включённого на выходе вольтметра. 

Наиболее простая схема включения дифференциального ИП (С1 и 
С2 на рисунке 2, б) реализуется на базе суммирующего усилителя 

(ОУ1 с конденсатором С3 в цепи обратной связи) с питанием ИП 

двухполярным напряжением  от трансформатора Т. Показанные на 
схеме паразитные ёмкости С1е–С4е по указанным выше причинам не 

оказывают влияния на работу ИП. При единичном коэффициенте 

трансформации выходное напряжение схемы 

 
 U0  =  Ui (С2 – C1)/С3.           (3) 

 

При указанных на схеме значениях параметров U0 = 1(20 · 0,5 – 20 ×  

× 0,45) / 10  =  0,1 В, что и регистрируется включённым на выходе 

вольтметром. 
Недостатком рассмотренной схемы является невозможность 

заземления ИП, что часто требуется на практике. Для исключения 

этого недостатка можно использовать мостовую схему включения 

ИП (элементы С1, С2 и С12 на рисунке 2, в) с использованием 
дифференциального усилителя на двух ОУ, в котором резистивные 

элементы цепи обратной связи заменены на ёмкостные. Коэффициент 

передачи такого усилителя равен 1 + С3/С4, а характеристика 
преобразования ИП на его базе 

 

 U0 = Ui (С1 – C2)(1 + С3/С4)/(1 + С1/С12)(1 + С2/С12).             (4) 
 

При указанных на схеме значениях параметров получаем:  

U0=1(20 · 0,55 – 20 · 0,5)(1 + 1/1)/(1 + 20 · 0,55/10)(1 + 20 · 0,5/10) = 0,0476 В, 

что практически совпадает с показанными на схеме результатами 
измерения.  
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Ещё один вариант включения дифференциального ИП с 
возможностью заземления нужной пары электродов (рисунок 3) 

представляет собой мостовой выпрямитель на диодах VD1–VD4, 

в одну диагональ которого включён ёмкостный ИП на С1, С2, а 
ко второй диагонали через конденсаторы С3 подключён 

источник измерительного напряжения Ui, при каждом 

полупериоде которого открывается соответствующая пара 
диодов – VD1, VD4 или VD2, VD3. При этом каждый из 

конденсаторов C3 соединяется последовательно, то с ёмкостью 

C1, то с ёмкостью C2 преобразователя. При нарушении 

равенства ёмкостей С1 и С2 токи через конденсаторы С3, 
текущие в положительном и отрицательном направлениях, 

будут не равны между собой, в результате чего на этих 

конденсаторах формируется постоянное напряжение, величина 
которого определяется приближённым соотношением  

 

U0 = Ui (С1 – C2)/(С1 + С2 + 2С1С2/С3). 

 
При указанных на схеме значениях параметров получаем: 

U0 = 30(200 · 0,55 – 200 · 0,5)/(200 · 0,55 + 200 · 0,5 + 2 · 200 · 0,55 · 200 · 0,5/100) = 0,698 

В, что на 3,5 % меньше полученного при моделировании. 

2 Порядок выполнения работы 

1 Изучите натурный образец ёмкостного датчика  с поворотным 

механизмом контроля перемещения и дополнительными 
подстроечными конденсаторами. 

2 Ознакомьтесь с методикой работы  в среде программы 

«Электронная лаборатория на ЭВМ» по пособию [1]. 

3 По указанию преподавателя включите ЭВМ. 
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а) 

 
б) 

 
в) 

 
 

Рисунок 2 – Схемы включения ИП ёмкостных датчиков  
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4 Руководствуясь формулой (1), в схеме на рисунке 2, а включите 
ёмкостный ИП (С1) таким образом, чтобы получить линейную 

характеристику преобразования. 

5 Используя формулу (4), исследуйте (с проверкой на модели) 

зависимость функций преобразования от ёмкости конденсатора С3. 

                       
Рисунок 3 – Схема включения ИП ёмкостных датчиков по мостовой схеме 

  

Содержание отчета 

Наименование и цель работы, краткая характеристика 

ёмкостных преобразователей и используемых приборов программы 

ЕWB, схемы моделируемых конденсаторных ИП и результаты их 
исследования, ответы на контрольные вопросы, выводы по работе. 

 

Контрольные вопросы и задания 

1 Какие функции преобразования могут быть реализованы ёмкостным 
измерительным преобразователем? 

2 Каким образом с помощью схем на рисунках 2, б и в можно сформировать 
реверсивную (двухтактную) характеристику преобразования? 

3 Используя формулы (1)–(4), составьте выражения для статических 
характеристик ИП для преобразования линейного перемещения путём изменения 
площади перекрытия и расстояния между электродами. 
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4 Если известно, что в ёмкостном ИП применяется источник измерительного 
напряжения частотой 100 кГц, то нужно ли учитывать инерционность такого ИП при 
его использовании в качестве датчика угловой скорости двигателя постоянного тока 
с номинальным значением n = 2000 об/мин? 

 

Л а б о р а т о р н а я  р а б о т а № 4   

ИЗУЧЕНИЕ  РЕОСТАТНЫХ И ПОТЕНЦИОМЕТРИЧЕСКИХ  

ИЗМЕРИТЕЛЬНЫХ ПРЕОБРАЗОВАТЕЛЕЙ  

 

Цель работы: изучить принципы построения и 
функционирования резисторных измерительных преобразователей, 

исследовать  электрические схемы потенциометрических датчиков  в 

среде Electronics Workbench. 

  

1 Краткие сведения из теории 

Потенциометрические датчики выполняются с использованием 
трех видов первичных преобразователей. 

Реостатные преобразователи выполняются в виде реостата, 

подвижный контакт которого перемещается под воздействием 
измеряемой величины (при включении такого ИП в цепь по схеме 

потенциометра используется термин «потенциометрические 

преобразователи»). Выходной величиной ИП является электрическое 

сопротивление, функционально связанное с положением  подвижного 
контакта при его вращательном или линейном перемещении. Так как 

в перемещение могут быть преобразованы многие неэлектрические 

величины (давление,  расход, уровень и др.), то реостатные 
преобразователи очень часто используются также в качестве 

промежуточных преобразователей неэлектрических величин в 

электрические. В устройствах телеметрии наибольшее 
распространение находят проволочные реостатные и реохордные 

(безвитковые) ИП, отличающиеся высокой точностью и 

стабильностью функции преобразования, возможностью получения 

необходимых функциональных зависимостей относительно 
простыми средствами, низкими значениями переходного 

сопротивления, уровня собственных шумов и температурного 

коэффициента сопротивления (ТКС). К недостаткам ИП относятся: 
подверженность электроэррозии из-за электрических разрядов при 

движении токосъемника, ограниченная скорость его перемещения и 
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низкая износоустойчивость, сравнительно невысокое сопротивление 
(до десятков килоом), ограниченная возможность применения на 

переменном токе (до 1000 Гц), обусловленная индуктивностью и 

емкостью обмотки; низкая разрешающая способность из-за 
дискретного характера изменения сопротивления (исключая 

реохордные). 

По конструктивному исполнению реостатные ИП делятся на 
преобразователи с поступательным (рисунок 1, а) и вращательным 

(рисунок 1, б) перемещениями подвижного контакта: последние, 

кроме того, бывают одно- и многооборотными. Реостатные ИП 

состоят из выводов 1–3, каркаса 4, токосъемного контакта 3, 
скользящего по виткам обмотки из высокоомного провода 5 с 

повышенной износо- и коррозионной стойкостью (различные сплавы 

платины, иридия, а также манганин, константан, фехраль и др.). 
Каркас из изоляционного материала (гетинакс, текстолит, керамика 

или металл, покрытый оксидной пленкой) может иметь форму 

стержня, кольца, изогнутой пластины и должен сохранять свои 

размеры в широком температурном диапазоне (в условиях 
повышенной влажности и химической загрязненности атмосферы), а 

также обладать высокой теплопроводностью для увеличения 

рассеиваемой ИП мощности. Диаметр обмоточного провода зависит 
от точности и номинального сопротивления ИП: 0,01 – 0,1 мм для 

датчиков высокого класса и 0,1–0,4 мм – низкого. Подвижный 

контакт (щетка, движок) изготавливаются в виде двух-трех 
параллельных проволочек диаметром 0,1–0,2 мм. 

Реохордные ИП выполняются в виде прямолинейного проводника 

или одного большого витка с токосъемным контактом. 

Преобразователи контактного сопротивления основаны на 
изменении (под действием давления) сопротивления между 

проводящими элементами, разделенными слоями резистивного 

материала; ИП такого типа имеют большие погрешности гистерезиса и 
линейности (до 10 %), но очень просты по конструкции и обладают вы-

сокой надежностью. ИП выполняется в виде столбика из ряда слоев 

электропроводящей бумаги, электропроводящей резины или 
металлических пластин, на которые путем напыления наносится 

высокоомный резистивный слой (или наполнение из угольного 

порошка, как в микрофонах). В качестве примера на рисунке 1, в 

показана конструкция ИП для пневморезисторного датчика, 
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содержащего два электрода 1 с припаянными к ним гибкими выводами 
5, 6 и приклеенным по периметру изолятором 4 из резины (3 – слой 

клея); внутренний объем 2 заполняется резистивным материалом. При 

изменении давления от 0 до 106 Па сопротивление ИП меняется от 100 
до 2 кОм при деформации чувствительного элемента до 50 %. 

Допустимая мощность рассеяния составляет 0,5 Вт. Аналогичные ИП 

используются в контактных датчиках  роботов, манипуляторов, в 
медицинских приборах (электростимуляторы с обратной связью по 

глубине дыхания пациента). 

Разновидностью контактных ИП являются тензолитовые 

преобразователи, которые выполняются в виде полосок, 
наклеиваемых на испытуемую деталь и состоящих из смеси графита, 

сажи, бакелитового лака и других компонентов. 

Тензолитовые ИП применяются при измерении 
быстроменяющихся ударных напряжений в движущихся деталях 

небольшого размера, при этом преобразователи работают как на 

растяжение, так и сжатие; коэффициент чувствительности выше, чем 

у тензорезисторов, и составляет 15–20. 
Тензорезистивные ИП характеризуются коэффициентом 

тензочувствительности  Кт = 1 + 2µ + δρ/δl, где µ – коэффициент 

Пуассона; δρ – относительное приращение удельного сопротивления 
ρ  при деформации δ1. Коэффициент тензочувствительности для 

металлов, наиболее часто применяемых для тензорезисторов, близок 

к двум: для константана – 2, нихрома – 2,2, хромеля – 2,5. Для по-
лупроводниковых материалов коэффициент 

тензочувствительности намного больше, чем у металлов 

(например, для германия он равен ~ 100), однако полупро-

водниковые тензометры характеризуются малой механической 
прочностью и существенной нестабильностью характеристик по 

сравнению с металлами.  

Тензорезисторы из металла разделяются на проволочные и 
изготавливаемые из фольги. Проволочные выполняются из 

проволоки диаметром 0,002–0,05 мм, которую укладывают петлями 

на тонкую бумагу или лаковую пленку с последующей пропиткой 
клеем Бф-2 для работы в диапазоне температур от минус 40 до плюс 

70 °С или бакелитовым лаком — при работе до плюс 200 °С; для более 

высоких температур используют специальные клеи и цементы. 

Тензорезистор наклеивается на поверхность испытуемой детали таким 
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образом, чтобы его продольная ось (база) была расположена в 
направлении измеряемой деформации детали, то есть, чтобы возможные 

деформации детали происходили вдоль проволочных петель резистора. 

Наиболее часто используют ИП с базой 5–20 мм; они имеют 
сопротивление 30–500 Ом, номинальный рабочий ток, определяемый 

условиями теплоотвода, – в пределах десятков миллиампер и 

максимально допустимые относительные деформации – не более 0,3  % . 

 
 

 

а) б) в) 

 

  

г) д) е) 

 
Рисунок 1 – Конструктивные схемы реостатных (а, б), контактного 

сопротивления (в) и тензометрических (г –е) ИП 
 

Поскольку изменение сопротивления тензорезисторов, вызванное 
деформацией, незначительно, и колеблется от единиц миллиом до 

нескольких десятков долей ома, то для измерений применяют 

высокочувствительные потенциометрические и  мостовые схемы. 

Для повышения чувствительности тензорезисторы включают в два  и 
даже четыре плеча мостовой схемы. Нелинейность статической 

характеристики проволочных тензорезисторов в пределах упругой 

деформации не превышает 0,1 %. 
Тензорезисторы из фольги более совершенны, чем проволочные. 

Они имеют решетку из тонких полосок фольги прямоугольного 

сечения толщиной 4–12 мкм, полученную травлением и нанесенную 



 40 

на лаковую подложку (рисунок 1, г–е). Благодаря большей площади 
контакта полосок тензорезистора с объектом измерения его 

теплоотдача значительно выше, чем у проволочного, что позволяет 

увеличить рабочий ток до 0,5 А и тем самым повысить 
чувствительность ИП. Другое достоинство  тензорезисторов из 

фольги заключается в возможности изготовления решеток сложного 

профиля, которые наиболее полно удовлетворяют условиям 
измерений. 

При использовании резисторных ИП в цепях переменного тока 

приходится учитывать реактивные составляющие сопротивления. Для ИП 

реохордного типа учитывается индуктивность: для линейного реохорда 
(проводник радиусом r0 и длиной l) L = µоl[ln(2l/r0) – 1]/2π; для 

вращательного (виток радиусом r из того же проводника) определяется по 

формуле 
 

L = µоr[ln(8r/rо) – 2],  

 

где µо=1,257·10-6 В·с/(А·м). 
В более общем случае резисторный ИП представляется 

последовательной или параллельной схемой замещения (рисунок 2, а, 

б), параметры которых определяются по формулам:  
 

     Rs = Ro [l + ω2Cs(2Ls– Cs R0
2)];      Xs = ω(Ls – Cs R0

2) = ω Le; 

     Rn = Ro[l + ω2 (Ls /R0)
2];          Xn = 1/ ω (Cs – Ls Ro

2) = l/ ω Ce, 
  

где Ro – сопротивление резисторного ИП на постоянном токе;  

Cs , Ls – емкость и индуктивность намотки. 

Расчеты показывают, что при постоянных времени Le/Ro 
или RoCe = 10-6 с,  изменение R0 на 0,01 % происходит на частоте 

1000 Гц. Аналогичное изменение R0 происходит на частоте 10 кГц за 

счет поверхностного эффекта. Уменьшение влияния Le достигается за 
счет использования бифилярной (в два провода) намотки, а Ce – за 

счет использования корректирующих конденсаторов. 

Резисторные ИП чаще используются с питанием на постоянном 
токе. При этом используются три схемы включения: 

последовательного, делителя и мостовая. Для последовательного  

включения (рисунок 2, в) выходное напряжение ИП 
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U0 = Ui Rn/(Rn + R0 ± ∆R).                (1) 
 

Для схем с делителем напряжения (рисунок 2, г) – 

 
    U0 = Ui Rn/(R0 ± ∆R)/[R0 (Rn + R0 ± ∆R) + Rn/(R0 ± ∆R);     (2) 

 

для схемы на рисунке 2, д – 
 

    U0 = Ui Rn/(R0  ± ∆R)/(2 R0Rn + R0
2 – ∆ R2).                  (3) 

 

Как следует из формул (1)–(3), зависимость U0 =f(Ui) для всех трех 
схем является  нелинейной; для схем делителей она становится 

линейной при Rn >> R0, однако общий недостаток  − наличие 

постоянной составляющей  − устраняется только применением 
мостовых схем  (рисунок 2, е–з), на которых резисторные ИП 

изображены переменными сопротивлениями. Выходной ток мостовых 

схем при питании от источника постоянного напряжения определяют из 

выражения 
  

Iн= Ui (R1R4 –R2 R3)/[Rn (R1 + R2)(R3 + R4) +  

                                    + R1R2(R3 + R4) + R3R4(R1 + R2)].    (4) 
 

При питании от источника постоянного тока (Ui в схемах 

рисунков 2, е–з  заменяется на Ii)  
 

Iн = Ii( R1R4 – R2R3)/[Rn(R1 + R2 + R3 + R4) + (R3 + R4)(R1 + R2)].  (5) 

 

Наибольший интерес представляет мостовая цепь с 
дифференциальным преобразователем, для которой возможны 

следующие варианты: включение половин ИП в плечи R1 и R2 или 

R1 и R3 при питании моста от источника заданного напряжения или 
от источника заданного тока и использовании ИП с функцией 

преобразования вида R = R0 + Кх. Для схемы на рисунке 2, е из 

выражения (4) получаем (здесь и далее принимается Rl = R2 = R3 = 
R4 = R0): 

 

     U0 = 0,5Ui (∆R/R0)/{l + (R0/Rn)[l – 0,5(∆R/R0)
2]}.         (6) 
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Из выражения (6) видно, что линейность функции 
преобразования U0 = f(R0) обеспечивается при Rn >> R0. Для той же 

схемы при питании от источника тока из формулы (5) получаем: 

 
 U0 = 0,5Ii∆R/(l + R0/Rn),   (7) 

 

т. е. характеристика преобразования линейна при любом значении 
нагрузки Rn. 

Мостовая схема на рисунке 2, ж при питании от источника 

напряжения нелинейна при любых значениях Rn, а при питании от 

источника тока линейна лишь при Rn >> R0, в чем можно убедиться, 
анализируя приводимые ниже выражения для их функций 

преобразования: 

    U0 = 0,5Ui(∆R/R0)/{[l – 0,25(∆R/R0)
2] + (R0/Rn)[l – 0,5(∆R/R0)

2]}.   (8)                                          

U0= 0,5Ii(∆R/R0)/{l + (R0/Rn)[l – 0,25(∆R/R0)
2]}.          (9) 

 

 
 а) б) в) г) д)  

   

 
 е) ж) з) 

Рисунок 2 – Последовательная (а) и параллельная (б) схемы замещения резисторного 
ИП и схемы его включения (в–з) 
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2 Порядок выполнения работы 

1 Изучить натурный образец потенциометрического датчика  с 

поворотным механизмом контроля перемещения и добавочными 

резисторами. 
2 Ознакомиться с методикой работы  в среде программы 

«Электронная лаборатория на ЭВМ» по пособию [1]. 

3 По указанию преподавателя включить ЭВМ. 
4 Подготовить схемы моделей для исследования резисторного ИП 

при включении его по схеме делителя (см. рисунок 2, г, д) при Ui = 1 В, 

R0 = 10 кОм, ΔR = 1, 2, 3, 5 и 8 кОм. В качестве нагрузки 

использовать мультиметр. Результаты моделирования сравните с 
расчетными по формулам (2) и (3). 

5  Составить схемы моделей мостовых схем включения ИП на 

рисунке 2, е– з. При Ui  = 1 В, Ii = 0,1 мА, R0 = 10 кОм, ΔR = 1, 3 и 5 
кОм проверить истинность формул (6)–(9) и полученных с их 

помощью выводов. В качестве нагрузки использовать мультиметр. 

Содержание отчета 

Наименование и цель работы, краткая характеристика 

резисторных преобразователей и используемых приборов программы 
ЕWB, схемы моделируемых ИП и результаты их исследования, 

ответы на контрольные вопросы, выводы по работе. 

Контрольные вопросы и задания 

 
1  Назовите типы резисторных преобразователей и области их    применения? 
2  Какой тип резисторного ИП используется для преобразования перемещений 

поплавкового уровнемера бензобака автомобиля? Почему при переполнении бака 
иногда возможны нулевые показания индикатора уровня на приборной доске?  

3  Принцип действия ИП контактного сопротивления основан на том, что при 
сдавливании резистивного материала увеличивается количество контактирующих 
друг с другом кристалликов. Возможен ли случай, когда после снятия давления 
некоторая часть кристалликов не вернется в исходное «неконтактное» состояние? 
Зависит ли такой процесс «укрупнения» от рабочего тока и времени работы ИП?  

4  Каким  образом   необходимо  расположить  тензорезистор,   показанный  на 
рисунке 1, д, на валу двигателя, чтобы можно было получить данные о его крутящем 
моменте? Какие при этом потребуются дополнительные устройства для связи 

тензорезистора с системой контроля или управления? 
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